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Part (1) 

Introduction to Spreadsheets   
 

         Spreadsheet application is a computer program that allows us to 

record, calculate and compare numerical or financial data. A spreadsheet 

is a configuration of rows and columns. Rows are horizontal vectors 

while columns are vertical vectors. A spreadsheet is also known as a 

worksheet.  MS Office Excel, Open Office Spreadsheet, etc. are examples 

of Spreadsheet software. 

1. Basic Concepts of Spreadsheet 

          A file in spreadsheet is known as a “Workbook”. A workbook is a 

collection of a number of “Worksheets”. At a time, only one worksheet 

can be made as active worksheet and that worksheet is available to a user 

for carrying out operations.  

         Worksheet names will be shown in the “Sheet Tab” at the bottom 

left of the window. Additional sheets can be added and its name can be 

changed, if required. 

       A worksheet consists of columns and rows that intersect to form 

cells. Each cell is identified by a cell reference, which combines the letter 

of the column and the number of the row. 
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2. Features of Spreadsheet 

        A spreadsheet is a grid of rows and columns in which you enter 

text, numbers, and the results of calculations 

3. Major features of Spreadsheets are: 

 

 It provides functions to create formulae to perform calculations on 

data. 

 Data can be presented in charts or diagram for easy analysis (eg. 

Bar diagram, pie chart etc.) 

 Can be used to store, arrange and filter data. 

 Conditional formatting can be used for Criteria based separation of 

data. 

 Data validation feature can be used to get the exact data. 

 

        The primary purpose of a spreadsheet is to solve problems 

involving numbers. The advantage of using a computer spreadsheet is 

that you can complete complex and repetitious calculations quickly and 

accurately.  
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4. MS Office Excel,2010 
 

›  Microsoft Excel 2010 is the spreadsheet program in Microsoft 

Office 2010,  that you can use to calculate, analyze, and manage data. The 

no. of columns in MS Excel 2010 is 16384 whereas the no. of rows is 

1,048,576. 

5. Starting Excel 

 Excel program window 
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6. Basic Features of Microsoft Excel 2010 
 

A. Saving a Workbook 

 

 The Save command saves an existing workbook, using its current 

name and save location.  

 The Save As command lets you save a workbook with a new 

name or to a new location. 
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B. Rows and Columns 

         The Worksheet in Microsoft Excel 2010 contains Rows and 

Columns in Table format. Rows are named numerically (1,2,.......) from 

top to bottom while Columns are referred by alpha characters 

(A,B,C,D,....) from left to right. 

 

 

C. Cell 

            In spreadsheet, a value or function or an arithmetic expression is 

recorded in cells. The intersection of a Row and a Column is called a cell. 

        A cell is identified by a combination of a letter (column header) and 

a number (row header). For example, the first cell of a worksheet is 

identified as A1 at column A and row 1. As in the case, the cell having 

address as G8 is in the G column and 8
th
 row. Each cell thus has a unique 

identification called as cell address. 
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D. Inserting Rows and Columns 

To insert a row: 

1. Select the row above which you want to insert a new row. 

2. On the Home tab, in the Cells group, click the Insert arrow, and 

then click Insert Sheet Rows 

To insert a column: 

1. Select the column to the left of which you want to insert a new 

column. 

2. On the Home tab, in the Cells group, click the Insert arrow, and 

then click Insert Sheet Columns 

Note : We can add or delete Rows and columns in a Spreadsheet. To add 

column, click at the column header (right click on the mouse), there we 

get an option to add column. Likewise we can add row. To delete column, 

click at the column header (right click on the mouse), there we get an 

option to delete column. Likewise we can remove a row. 
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E. Deleting Rows and Columns 

 To delete a row or column, click the appropriate row or column 

heading and then click the Delete button on the Home tab. 

 Use the buttons in the Cells group on the Home tab to insert and 

delete cells. 
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F. Ranges 

        Range is a group of adjacent cells that forms a rectangular area. A 

range may contain just a single cell, or many cells. A range is specified 

by giving the address for first cell in the range and the last cell in the 

range. For example the range starting from B1 to B5 is written as B1:B5, 

where colon (:) is the range operator. 

In an adjacent range, all cells touch each other and form a rectangle. 

 To select an adjacent range, click the cell in a corner of the range, 

drag the pointer to the cell in the opposite corner of the range, and 

release the mouse button. 

A nonadjacent range includes two or more adjacent ranges and selected 

cells.  

 To select a nonadjacent range, select the first adjacent range or cell, 

press the Ctrl key as you select the other cells or ranges you want 

to include, and then release the Ctrl key and the mouse button. 
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G. Naming Cells and Ranges 

          Naming ranges in excel 2010 will save time for writing complex 

formulas. The name can be used in place of cell range whenever reference 

it e.g. in D4 we have =SUM(B2:F2). 

 

H. Cell Reference 

          A cell reference identifies the location of a cell or group of cells in 

the spreadsheet also referred as a cell address. Cell references are used in 

formulas, functions, charts, other Microsoft Excel 2010 commands and 

also refer to a group or range of cells. Ranges are identified by the cell 

references of the cells in the upper left (cell A1) and lower right (cell E2) 
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corners in . The ranges are identified using colon (:) e.g. A1: E2 which 

tells Microsoft Excel 2010 to include all the cells between these start and 

end points. 

 Relative Cell Reference: By default cell reference is relative; 

which means that as a formula or function is copied and pasted to 

other cells, the cell references in the formula or function change to 

reflect the new location. 

 Absolute cell reference: The other cell reference is absolute cell 

reference which consists of the column letter and row number 

surrounded by dollar ($) signs e.g. $C$4. An absolute cell 

reference is used when we want a cell reference to stay fixed on 

specific cell, which means that when a formula or function is 

copied and pasted to other cells, the cell references in the formula 

or function do not change. 

 Mixed cell reference: It is a combination of relative and absolute 

Cell references that holds either row or column constant when the 

formula or function is copied to another location e.g., $C4 or C$4. 

 References preceded by a dollar sign do not change. 
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Mixed cell references 

 

7. Moving the Active Cell in a Worksheet 

          We can move around a worksheet through four arrow keys (i.e. left, 

right, up, down). The mouse can also be used for navigation in Sheet 

except data entry. Some of the important operations and common 

navigations can be performed by using key strokes (Press Key) as shown 

in Table 1.  

         Pressing a key is called key stroke but to fulfill one command for 

operation in the Sheet some time we require pressing two keys together to 

get one key stroke. 

 

 

 



21 

 

Table (1) 

Keys for moving the active cell in a worksheet 

 

 
 
 

8. Labels 

       A text or a special character will be treated as labels for rows or 

columns or descriptive information. Labels cannot be treated 

mathematically-multiplied, subtracted, etc. For example Name of 

Employees, Date of birth. 
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9. Formulas 

         The formula means a mathematical calculation on a set of cells. 

Formulas must start with an „ = „ sign (equal to sign), e.g. If the cell E3 

have formula = D1+E1 which gives the sum of numbers in cell D1 and 

E1 in E3. 

        A spreadsheet without any formulas is a collection of data which are 

arranged in rows and columns (a database) like a calendar, timetable or 

simple list, etc. There is a input Line (Formula bar) on Microsoft Excel 

2010 toolbar and by using function wizard available in it we can insert 

any functions in spreadsheet. 

10.  Entering Data in a Cell 

Worksheet cells can contain text, numbers, or formulas.  

 Text is any combination of letters and numbers and symbols.  

 Numbers are values, dates, or times. 

 Formulas are equations that calculate a value.   

You enter data in the active cell.  

 The simplest way to enter data is to click a cell and type a value. 

This method works very well when you‟re entering a few pieces of 

data, but it is less than ideal when you‟re entering long sequences 

or series of values. 
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 Data Entry 

a. Repeatedly entering the sequence January, February, March, 

and so on can be handled by copying and pasting the first 

occurrence of the sequence, but there‟s an easier way to do 

it: use AutoFill. 

b.With AutoFill, you enter the first element in a recognized 

series, click and hold the mouse button down on the fill 

handle at the lower-right corner of the cell, and drag the fill 

handle until the series extends far enough to accommodate 

your data. 

c. Using a similar tool, FillSeries, you can enter two values in a 

series and use the fill handle to extend the series in your 

worksheet. For example, if you want to create a series 

starting at 2 and increasing by 2, you can put 2 in the first 

cell and 4 in the second cell, select both cells, and then use 

the fill handle to extend the series to your desired end value. 

ii. You do have some control over how Excel extends the values in a 

series when you drag the fill handle. For example, if you drag the 

fill handle up (or to the left), Excel extends the series to include 

previous values. If you type January in a cell and then drag that 
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cell‟s fill handle up (or to the left), Excel places December in the 

first cell, November in the second cell, and so on. 

iii. Another way to control how Excel extends a data series is by 

holding down the Ctrl key while you drag the fill handle. For 

example, if you select a cell that contains the value January and 

then drag the fill handle down, Excel extends the series by placing 

February in the next cell, March in the cell after that, and so on. If 

you hold down the Ctrl key while you drag the fill handle, 

however, Excel repeats the value January in each cell you add to 

the series. 

iv. Other data entry techniques you‟ll use in this section are 

AutoComplete, which detects when a value you‟re entering is 

similar to previously entered values; and Ctrl+Enter, which you can 

use to enter a value in multiple cells simultaneously. 
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The following table (2) summarizes these data entry techniques. 

Method Action 

AutoFill Enter the first value in a recognized series and use the 

fill handle to extend the series. 

Fill Series Enter the first two values in a series and use the fill 

handle to extend the series. 

AutoComplete Type the first few letters in a cell, and if a similar 

value exists in the same column, Excel suggests the 

existing value. 

Pick From Drop-

Down List 

Right-click a cell, and then click Pick From Drop-

Down List. A list of existing values in the cell‟s 

column is displayed. Click the value you want to enter 

into the cell. 

Ctrl+Enter Select a range of cells, each of which you want to 

contain the same data, type the data in the active cell, 

and press Ctrl+Enter. 

 

11.  Changing Data in a Cell 

 You can edit, replace, or clear data.  

 You can edit cell data in the Formula Bar or in the cell. The 

contents of the active cell always appear in the Formula Bar.  

 To replace cell data, select the cell, type new data, and press the 

Enter button on the Formula Bar or the Enter key or the keyboard.  

 



26 

 

 

12.  Searching for Data 

 The Find command locates data in a worksheet, which is 

particularly helpful when a worksheet contains a large amount of 

data. You can use the Find command to locate words or parts of 

words.  

 The Replace command is an extension of the Find command. 

Replacing data substitutes new data for the data that the Find 

command locates. 

 

13. Resizing Columns and Rows 

 Resize a column by placing the pointer on the right edge of the 

column heading and dragging. For a precise column width, enter 

the value in the Column Width dialog box. 

 To change the row height, drag the border of the row heading or 

enter a height in the Row Height dialog box. 
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 AutoFit determines the best width for a column or the best height 

for a row. 

 Place the pointer on the right edge of the column heading (or below 

the row heading) until the pointer changes to a double-headed 

arrow. Then, double-click to resize the column or row to the best 

fit. 
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14. Positioning Data Within a Cell 

 By default, text you enter in a cell is lined up along the bottom-left 

side of the cell, and numbers you enter in a cell are lined up along 

the bottom-right. 

 However, you can position data within a cell in a variety of ways 

using the buttons on the Home tab of the Ribbon. 

Table (3) Positioning data within a cell 
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 You can align the contents of a cell horizontally and vertically 

within the cell. To change the alignment of a cell, select the cell 

and then click an alignment button on the Home tab. 

 You can also merge cells which combines them into one cell. 

 Indent data within cells by using the Increase Indent and Decrease 

Indent buttons on the Home tab. 

15.  Freezing Panes in a Worksheet 

 You can view two parts of a worksheet at once by freezing 

panes. 

 When you freeze panes, you select which rows and/or columns 

of the worksheet remain visible on the screen as the rest of the 

worksheet scrolls. 
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16. Splitting a Worksheet Window 

 Splitting divides the worksheet window into two or four panes that 

you can scroll independently.  

 This enables you to see different parts of a worksheet at the same 

time.  

 Worksheet window split into horizontal panes. 
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17. Preparing a Worksheet for Printing 

 So far, you have worked in Normal view, which is the best 

view for entering and formatting data in a worksheet.  

 Page Layout view shows how the worksheet will appear on 

paper, which is helpful when you prepare a worksheet for 

printing. 

 The margin is the blank space around the top, bottom, left, 

and right sides of a page. 

 Margins menu 

 

 

 By default, Excel is set to print pages in portrait orientation. 

Worksheets printed in portrait orientation are longer than they are 

wide. In contrast, worksheets printed in landscape orientation are 

wider than they are long.  



32 

 

 The print area consists of the cells and ranges designated for 

printing. 

 Excel inserts an automatic page break whenever it runs out of 

room on a page. You can also insert a manual page break to start 

a new page. 

 The simplest way to adjust page breaks is in Page Break Preview. 

On the status bar, click the Page Break Preview button to switch to 

this view. 

 Scaling resizes a worksheet to print on a specific number of pages. 

The Scale to Fit group contains the three options shown below. 

Scale to Fit group on the Page Layout tab 

 

 

 By default, gridlines, row numbers, and column letters appear in 

the worksheet but not on the printed page. You can choose to show 

or hide gridlines and headings in a worksheet or on the printed 

page.  

 Print titles are designated rows and/or columns in a worksheet that 

are printed on each page.  
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Exercises 

1. What is Spreadsheet ? 

2. Mention the purpose of Spreadsheet. 

3. What are the features of spreadsheet? 

4. What is range? 

5. What is cell Reference? 

6. What do you mean by Relative cell reference? 

7. What do you mean by Absolute cell reference? 

8. What do you mean by Mixed cell reference? 

9. Name box displays………………….. 

10. The intersection of a Row and a Column is called............. 

11. .........................must start with an „ = „ sign in Microsoft Excel 

2010 (equal to sign) 

12. Input Line is also known as ......................................... 
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Part (2) 

Using Formulas (Functions) 

Introduction: 

           A function is a special key word which can be entered into a cell 

in order to perform and process the data which is appended within 

brackets. There is a function button f(x) on the formula bar. When we 

click on it, function offers assistance through function wizard. 

Alternatively we can enter the function directly into the formula bar. 

 

      A function is a built in set of formulas which starts with an „equal to 

sign‟(=) such as = Function Name (Data). The data or argument includes 

a range of cells. 

1. What Are Formulas? 

 The equation used to calculate values based on numbers entered 

in cells is called a formula.  

 Each formula begins with an equal sign (=). 

 The results of the calculation appear in the cell in which the 

formula is entered.  

 Formula and formula reset. 
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2. Entering a Formula  

 Worksheet formulas consist of two components: 

 operands 

 operators 

 An operand is a constant (text or number) or cell reference used in 

a formula.  

 An operator is a symbol that indicates the type of calculation to 

perform on the operands, such as a plus sign (+) for addition. 
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 Mathematical operators 

 

 A formula with multiple operators is calculated using the order of 

evaluation.  

 Contents within parentheses (beginning with innermost) are 

evaluated first.  

 Mathematical operators are evaluated in a specific order. 

(Shown in table on next slide). 

 If operators have the same order of evaluation, the equation 

is evaluated from left to right.  

 Order of evaluation 
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3. Editing Formulas 

 If you enter a formula with an incorrect structure in a cell, Excel 

opens a dialog box that explains the error and provides a possible 

correction.  

Formula error message 

 



43 

 

 If you discover that you need to make a correction, you can edit the 

formula.  

 Click the cell with the formula you want to edit. Press the F2 key or 

double-click the cell to enter editing mode or click in the Formula 

Bar. 

 

 

4. What Are Functions? 
 

 A function is a shorthand way to write an equation that 

performs a calculation.  

 A formula with a function has three parts:  

 The equal sign identifies the cell contents as a formula.  

 The function name identifies the operation to be 

performed.  
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 The argument is the value the function uses to perform 

a calculation. 

 Parts of a function 

 

 

 Entering Formulas with Functions 

 

 To enter a formula with a function, you need to do the following.  

 Start the formula with an equal sign. 

 Select or enter the function you want to use.  

 Select or enter the arguments.  

 Enter the completed formula.  

 To open the Insert Function dialog box, click the Insert Function 

button on the Formula Bar. 

 Insert Function dialog box 
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 You can also enter a formula with a function directly in a cell by 

typing an equal sign, the function name, and the argument.  

 Formula AutoComplete helps you enter a formula with a valid 

function name and arguments.  

 As you begin to type the function name, a list of function 

names appears below the active cell. 
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5. Types of Functions 

 Mathematical functions and trigonometric functions manipulate 

quantitative data in a worksheet.  

 Some mathematical operations, such as addition and  subtraction, 

do not require functions.  

 Mathematical and trigonometric functions are particularly useful 

when you need to determine values such as logarithms, factorials, 

and sines. 
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A.  Some Mathematical functions 

Function                                Description 

ABS function Returns the absolute value of a number 

CEILING function Rounds a number to the nearest integer or to 

the nearest multiple of significance 

FLOOR function Rounds number down, toward zero, to 

the nearest multiple of significance 
 

INT function Rounds a number  down to 

the nearest  integer 
    

ROUND function Rounds a number to a specified number 

of digits 
  

SUM function Adds its arguments    

SUMIF function Adds the cells specified by a given 

criteria 
   

 

 Example on SUMIF function 

1. Calculate the total sales amounts for this week? 

2. Calculate the total sales for days that the sales amount exceeds 

500? 

3. Calculate the sales amount for days in which the quantity sold 

exceeds 5 units? 

 

 

 

ms-help://MS.EXCEL.14.1033/EXCEL/content/HP10342132.htm
ms-help://MS.EXCEL.14.1033/EXCEL/content/HP10342225.htm
ms-help://MS.EXCEL.14.1033/EXCEL/content/HP10342531.htm
ms-help://MS.EXCEL.14.1033/EXCEL/content/HP10342625.htm
ms-help://MS.EXCEL.14.1033/EXCEL/content/HP10342858.htm
ms-help://MS.EXCEL.14.1033/EXCEL/content/HP10342931.htm
ms-help://MS.EXCEL.14.1033/EXCEL/content/HP10342932.htm
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Day Quantity Sales 

Amount 

Saturday 1 234 

Sunday 3 144 

Monday 6 367 

Tuesday 5 674 

Wednesday 8 1099 

Thursday 3 233 

Friday 7 869 

 

 

 

 
 

 

 The total sales amounts for this week = 3620 
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 The total sales for days that the sales amount exceeds 500= 

2642 

 

 

 The sales amount for days in which the quantity sold 

exceeds 5 units= 2335 

 
  

 

 

Statistical functions 

 Statistical functions are used to describe quantities of data.  

 For example, statistical functions can determine:  

 the average, standard deviation, or variance of a range of 

data.  

 the number of values in a range, the largest value in a range, 

and the smallest value in a range. 
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Exercise 

›  The following table shows students marks in 3 subjects: 

NAME ACCOUNTING MANAGEMENT STATISTICS 

A 61 55 55 

B ABSENT 40 ABSENT 

C 92 65 80 

D 85 45 ABSENT 

E 67 29 17 

F 52 ABSENT 65 

G 35 17 6 

H 68 83 90 

I 71 ABSENT 86 

J 61 50 ABSENT 

›   

›  Required: 

1. Calculate the number of students in each subject? 

2. Calculate the number of students that  attended the exam for each 

subject? 

3. Calculate the number of passed students in each subject? 

4. Calculate the number of students who got excellent and those who 

got v. good in each subject? 

5. Determine the student who got the best mark in each subject and 

the one who got the worst mark? 

6. What is the average mark in each subject? 
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 The number of students in each subject  

 

ACCOUNTING MANAGEMENT STATISTICS 

10 10 10 

 

 
 

 

 The number of students that attended the exam 

for each subject. 

ACCOUNTING MANAGEMENT STATISTICS 

9 8 7 
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 The number of passed students in each subject 

 

 

 

 

 

 
 

 The number of students who got excellent and in 

each subject. 

 

  

 

 

 

 

 

ACCOUNTING MANAGEMENT STATISTICS 

4 4 5 

ACCOUNTING MANAGEMENT STATISTICS 

1 0 1 
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 The number of students who got v.good in each 

subject 

 

 

 

 

 The number of students who got the best mark in 

each subject. 

 

 

 

 

 

 

 

ACCOUNTING MANAGEMENT STATISTICS 

1 1 2 

ACCOUNTING MANAGEMENT STATISTICS 

92 83 90 
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 The number of students who got the worst mark 

in each subject. 

 

 

 

 

 The average mark in each subject 

 

 

 

 

 

 

 

 

 

ACCOUNTING MANAGEMENT STATISTICS 

35 17 6 

ACCOUNTING MANAGEMENT STATISTICS 

65.77777778 48 57 
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B. Financial Functions 

       

         These functions perform many of the common financial 

calculations, such as the calculation of interest rates, duration, valuation 

and depreciation. 
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Examples 
 

1. Calculate the future value for a series of L.E. 50 monthly deposits 

that last for five years assuming 12% annual interest rate? 

Note: To show FV in positive you should enter the value of periodical 

payments in negative. 

2. If you have two options for buying a car: 

A. By it on cash for L.E. 52,000. 

B. By it on quarterly  installments over three years. The value of 

each one is L.E. 5000. The first payment is due in three months. 

Interest rate is 12%. 

Which option you should select? 

3. Suppose that you got L.E. 30,000 loan from a bank to be repaid on 

equal monthly payments over three years. What is the value of 

monthly installments assuming 7% interest rate? Assume that the 

installments are due at the beginning of each month? 

4. Solve the previous example if the interest rate is the unknown 

value? 
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Solution Example (1) 

Step by Step: 

1. Open a new book in Microsoft Excel 2010. 

2. In cell B1 write the value of annuity (50). 

3. In cell B2 enter the number of years (5) 

4. In cell B3 write the number of periods by entering the formula 

“=B2*12. 

5. In cell B4 enter the value of interest rate (12%). 

 

6. In cell B5 enter the function FV and enter the following values in 

the Function  argument box: 

A. Refer to cell B4 to enter the value of Rate box. 

B. Refer to cell B3 to enter the value of Nper box. 

C. Refer to cell B1 to enter the value of Pmt box. 

D. Leave the value of Pv box empty. 

E. Write zero in the type box or leave it empty. 
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F. Press enter key on keyboard or OK in the Function argument 

box. 

 

 

 

Note: To show FV in positive you should enter the value of periodical 

payments in negative. 
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Solution Example (2) 

Step by Step: 

1. Open a new book in Microsoft Excel 2010. 

2. In cell B1 write the value of annuity (5000). 

3. In cell B2 enter the number of years (3) 

4. In cell B3 write the number of periods by entering the formula 

(=B2*4). 

5. In cell B4 enter the value of interest rate (3%) Or (=12%/4). 

 

 

 

6. In cell B5 enter the function PV and enter the following values in 

the Function  argument box: 

A. Refer to cell B4 to enter the value of Rate box. 

B. Refer to cell B3 to enter the value of Nper box. 

C. Refer to cell B1 to enter the value of Pmt box. 

D. Leave the value of Fv box empty. 

E. Write zero in the type box or leave it empty. 
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F. Press enter key on keyboard or OK in the Function 

argument box. 
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Solution Example (3) 

Step by Step: 

1. Open a new book in Microsoft Excel 2010. 

2. In cell B1 write the value of annuity (-30000). 

3. In cell B2 enter the number of years (3) 

4. In cell B3 write the number of periods by entering the formula 

(=B2*12). 

5. In cell B4 enter the value of interest rate (1%) Or (=7%/12). 

 
 

6. In cell B5 enter the function (PMT) and enter the following values 

in the Function  argument box: 

A. Refer to cell B4 to enter the value of Rate box. 

B. Refer to cell B3 to enter the value of Nper box. 

C. Refer to cell B1 to enter the value of PV box. 

D. Leave the value of FV box empty. 

E. Write zero in the type box or leave it empty. 
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F. Press enter key on keyboard or OK in the Function argument 

box. 
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Solution Example (4) 

Step by Step: 

1. Open a new book in Microsoft Excel 2010. 

2. In cell B1 write the value of annuity (-30000). 

3. In cell B2 enter the number of years (3) 

4. In cell B3 write the number of periods by entering the formula 

(=B2*12). 

5. In cell B4 enter the value of monthly installments (920.94)  

 

5. In cell B5 enter the function (RATE) and enter the following 

values in the Function  argument box: 

A. Refer to cell B3 to enter the value of NPER box. 

B. Refer to cell B4 to enter the value of PMT box. 

C. Refer to cell B1 to enter the value of PV box. 

D. Leave the value of FV box empty. 

E. Write Zero in the type box or leave it empty. 
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F. Press enter key on keyboard or OK in the Function argument 

box. 
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Example on Depreciation Function 

 

 

        ABC company purchased a machine for L.E. 50,000, the estimated 

useful life is 4 years and the estimated residual value is L.E. 10,000. 

Calculate the annual depreciation expenses using the following 

depreciation methods: 

A. Straight Line 

B. Declining Balance (assuming Dep. Rate is 33.1%) 

C. Double Declining Balance 

D. Sum of the Year Digits 

     Using Microsoft Excel 2010, show theoretically,the steps of 

calculating the following:  

A. Straight Line Depreciation 

 

1. Open a new book in Microsoft Excel 2010. 

2. In cell A1 enter the cost of the machine (50,000) 

3. In cell A2  enter the salvage value (10,000). 

4. In cell A3 enter the useful life (4) 

5. In cell B1 insert SLN function from financial formulas menu. 
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6. In function argument box refer to cell A1 in the cost box, refer 

to cell A2 for the salvage value box, and refer to cell A3 in the 

useful life box. 

 

 

 

7. press enter from the keyboard or press OK tab on the function 

argument box. 
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B. Declining Balance Method 

 

1. Open a new book in Microsoft Excel 2010. 

2. In cell A1 enter the cost of the machine (50,000) 

3. In cell A2  enter the salvage value (10,000) 

4. In cell A3 enter the useful life (4) 

5. In the range B1: B4 enter the years‟ of asset‟s life 1,2,3,4 

6. In cell C1 enter the function DB from financial functions. 

 

 

 

7. In the function argument box: 

i. refer to cell A1 on the cost box with making it as an absolute 

reference not relative, by inserting the dollar sign before the 

row number or before both column and row numbers. 

ii. refer to cell A2 on the salvage value box with making it as an 

absolute reference. 

iii. refer to cell A3 on the life box with making it as an absolute 

reference. 
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iv. refer to cell B1 in the period box but keep it as a relative 

reference. 

v. for the month box leave it empty meaning the depreciation 

period in the first year is 12 months as it did not mention in 

the question the exact date of purchasing the asset. 

 

 

 

8. calculate the value of depreciation in the first year by pressing 

enter from the keyboard or press OK tab on the function argument 

box. 

9. Use Autofill to get the value of depreciation expense for year 2, 3, 

and 4 
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C. Double Declining Balance Method 

 

1. Open a new book in Microsoft Excel 2010. 

2. In cell A1 enter the cost of the machine (50,000) 

3. In cell A2  enter the salvage value (10,000) 

4. In cell A3 enter the useful life (4) 

5. In the range B1: B4 enter the years‟ of asset‟s life 1,2,3,4 

6. In cell C1 enter the function DDB from financial functions. 

 
 

7. In the function argument box: 

i. Refer to cell A1 on the cost box with making it as an absolute 

reference not relative, by inserting the dollar sign before the 

row number or before both column and row numbers. 

ii. Refer to cell A2 on the salvage value box with making it as an 

absolute reference. 

iii. Refer to cell A3 on the life box with making it as an absolute 

reference.  

iv. Refer to cell B1 in the period box but keep it as a relative 

reference. 
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v. For the factor box leave it empty meaning to use double the 

normal depreciation rate. 

 

 

8. Calculate the value of depreciation in the first year by pressing 

enter from the keyboard or press OK tab on the function argument 

box. 

9. Use Autofill to get the value of depreciation expense for year 2, 3, 

and 4. 
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D. Sum of the Year Digits Method 

 
1. Open a new book in Microsoft Excel 2010. 

2. In cell A1 enter the cost of the machine (50,000) 

3. In cell A2  enter the salvage value (10,000) 

4. In cell A3 enter the useful life (4) 

5. In the range B1: B4 enter the years‟ of asset‟s life 1,2,3,4 

6. In cell C1 enter the function SYD from financial functions. 

 

 

7. In the function argument box: 

i. refer to cell A1 on the cost box with making it as an absolute 

reference not relative, by inserting the dollar sign before the 

row number or before both column and row numbers. 

ii. refer to cell A2 on the salvage value box with making it as an 

absolute reference. 

iii. refer to cell A3 on the life box with making it as an absolute 

reference. 

iv. refer to cell B1 in the period box but keep it as a relative 

reference. 
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8. calculate the value of depreciation in the first year by pressing 

enter from the keyboard or press OK tab on the function argument 

box. 

9. Use Autofill to get the value of depreciation expense for year 2, 3, 

and 4. 
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A. Logical Functions 

 

 

 

 Example for Using IF Function 

 

        

     The following table represents the sales revenues for goods sold 

through company‟s agents during the month of January: 

 
 

Example (1) 

          Compute the sales commissions for each agent if you know that the 

agents who achieve more than 30,000 monthly sales get 10% 

commission, whereas those who achieve 30000 or less gets only 5%? 
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Step by Step: 

1. Open a new book in Microsoft Excel 2010. 

2. In cell A1 write the company's Agents. 

3. In cell A2:A6  enter the Agents names. 

4. In cell B1 write the sales. 

5. In cell B2:B6 enter the value of monthly sales revenues. 

 

 

6. In cell C1 enter the function IF and enter the following 

values in the function argument box: 

i. Refer to cell B2 and write the condition >30000 in the 

logical test box.  

ii. Refer to cell B2 and multiply it by 10% commission 

B2*10% in the value- If-true box. 

iii. Refer to cell B2 and multiply it by 5% commission 

B2*5% in the value- If- flase box. 

iv. Press OK in the Function argument box. 
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 Example for Combining IF function with AND 

Function 

 

›  By itself, the AND function has limited usefulness. By combining it 

with another function, such as the IF function, the AND function can 

increase the capabilities of your spreadsheet.  

Example (2) 

        The following is the data for a group of persons who apply to a job 

in Red Sea governorate: 

 

 

        Determine the accepted persons if the job requires that applicant 

should have a V. Good grade, and his birth place and residence is Red 

Sea?  
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Step by Step: 

1. Open a new book in Microsoft Excel 2010. 

2. In cell (A1,B1,C1,&D1) write (Name, Grade, Birth Place& 

Residence) respectively. 

3. In cell (A2:A5)  enter the applicants names. 

4. In cell (B2:B5)  enter the applicants' Grade. 

5. In cell (C2: C5)  enter the applicants Birth Place. 

6. In cell (D2:D3) enter the applicants Residence. 

 

7. In cell E1 enter the function AND and enter the following 

values in the function argument box: 

i. Refer to cell B2 and write the condition (B2="V.Good") 

in the (logical1) test box.  

ii. Refer to cell C2 and write the condition (C2="Red 

Sea") in the (logical2) test box  
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iii. Refer to cell D2 and write the condition (B2="Red 

Sea") in the (logical3) test box 

iv. Press OK in the Function argument box. 

 

 

Combining IF function with OR Function 

 By itself, the OR function has limited usefulness. By combining it 

with another function, such as the IF function, the AND function can 

increase the capabilities of your spreadsheet.  
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Example (3) 

         Suppose in the previous example, the applicants who got less than 

V. Good have been excluded, so now all applicants have V. Good grade.  

 Determine the accepted persons if the conditions modified so that 

the applicant should be either born or residing in Red Sea? 

 

Step by Step: 

1. Open a new book in Microsoft Excel 2010. 

2. In cell (A1,B1,C1,&D1) write (Name, Grade, Birth Place& 

Residence) respectively. 

3. Delete the applicant with Grade less than very good. 

4. In cell (A2:A4)  enter the applicants names. 

5. In cell (B2:B4)  enter the applicants' Grade. 

6. In cell (C2: C4)  enter the applicants Birth Place. 

7. In cell (D2:D4) enter the applicants Residence. 
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8. In cell E2 enter the function OR and enter the following 

values in the function argument box: 

i. Refer to cell C2 and write the condition (C2=" Red Sea") 

in the (logical1) test box.  

ii. Refer to cell D2 and write the condition (D2="Red Sea") 

in the (logical2) test box  

iii. Press OK in the Function argument box. 
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Combining IF function with OR Function 

 By itself, the OR function has limited usefulness. By combining 

it with another function, such as the IF function, the AND function 

can increase the capabilities of your spreadsheet.  

 = IF(AND Function, "Accepted","Rejected) 

In cell E2 edit and combine IF function with OR function as follow: 

=IF (OR Function,"Accepted",Rejected). 

i. Write (IF) after equal (=) sign, then open "bracket("before OR 

function. 

ii. Write (IF) after AND function, then write 

("Accepted")&(Rejected"). 

iii. Close the "bracket & press enter 

iv. Use Autofill to Get the accepted and rejected applicants. 
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Part (3) 

 Application of Cost-Volume-
Profit Analysis (CVP) 
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Part (3)  

Application of Cost-Volume-Profit Analysis (CVP) 
 

What is CVP? 

          CVP analysis explores the relationship between revenue, cost, and 

volume and their effect on profits. 

 

 The Income Statement 

Profit Equation 

 Total revenues - Total costs 

Profit Equation =  

 Operating profit 

 

 The Income Statement written horizontally 

Operating profit = Total revenues - Total costs 

     

Profit = TR - TC 

 

Total revenue (TR) = Average selling 

price per unit (P) 

× Units of output 

produced and sold (X) 

TR = PX 

 

 

 

 

Total cost (TC) 
 

 

= 

Variable cost 

per unit (V) 

× Units of 

output (X) 

 

+ 

Fixed costs 

(F) 

 

TC = VX + F 
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Profit  = Total revenue – Total costs 

   = TR – TC 

 TC = VX + F 

 

Therefore, Profit = PX – (VX + F) 

Profit = (Price – Variable costs) × Units of output – Fixed costs 

   = X(P – V) – F 

 

 Contribution Margin 

This is the difference between price and variable cost 

• It is what is leftover to cover fixed costs and then add 

 to operating profit. 

Contribution margin = Price per unit – Variable cost per unit 

                                  =P – V 
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CVP Example 

 

U-Develop 

Income Statement 

For the Month Ending March 20XX 

 

 

• Contribution margin per unit = $2,880 ÷ 12,000 = $0.24 

 

 Break-Even Volume in Units 

This is the volume level at which profits equal zero 

Profit 0 = X(P – V) – F 

If profit = 0, then X = F ÷ (P – V) 
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 Break-Even Volume in Sales Dollars 
 

      Contribution margin percentage (contribution margin ratio) is the 

contribution margin as a percentage of sales revenue. 

 What is the contribution margin percentage? 

$0.24 ÷ $0.60 = 0.40 (or 40%) 

$1,500 ÷ 0.40 = $3,750 

 

Assume that management wants to have a profit of $1,800. 

 How many prints must be sold? 

               ($1,500 + $1,800) ÷ $.24 = 13,750 

 

 What is the target dollar sales? 

               ($1,500 + $1,800) ÷ 0.40 = $8,250 

 

 Assuming 5000 units volume; what price do U-Develop needs to 

charge to break even? 

 FC 

B.E. (units) =  

 CM 
 

 

 FC 

B.E. (units) =  

 (P –V) 

  

 1500 

5000 =  

 (P –0.36) 
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5000 (P - 0.36) = 1500 

 5000 p – 1800 = 1500 

 5000 p = 3300 

P = 3300 ÷  5000 = $0 .66 

 

 CVP Summary: Break-Even  

 

 

 CVP Summary: Target Volume 

 

 

  

 CVP Analysis with Spreadsheets 

›        CVP can be done using Microsoft Excel. It can be done using 

Goal Seek Command from What IF Analysis Menu. 
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›  Example 

 

U-Develop company data were as follows: 

Price =$0.60 

Variable Cost /unit=$0.36 

Total Fixed Costs= $1500 

Required 

Using the Goal Seek function in Microsoft Excel, 

a. What number must  U-Develop sell to break even? What is the 

dollar sales break even? 

b. What number must U-Develop sell to make an operating profits t 

of $300 per month? 

c. Assuming 5000 units volume; what price do U-Develop needs to 

charge to break even? 
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Solution 

(a) What number must  U-Develop sell to break even? What is the 

dollar sales break even? 

1. Open Microsoft Excel worksheet 

2. Enter the unit price ($0.60) in cell B3; Variable cost per unit 

($0.36) in cell B4; total Fixed Costs ($1500) in cell B5; 

Volume in cell B8. 

3. Enter the formula of profits in cell B7 which is as 

follows:"=B8*(B3-B4)-B5" 

4. With the spreadsheet open, choose the “Data” tab and select 

“What-If Analysis” from the ribbon. Then select “Goal 

Seek” from the drop-down box. 

5. In the “Set cell:” edit field, enter the cell address for the 

target profit calculation (B7). 

6. In the “To value:” edit field, enter the target profit (in this 

example, the target profit is zero because we are looking for 

the break-even point). 

7. In the “By changing cell:” edit field, enter the cell address of 

the volume variable ($B$8). 

8. Click “OK” and the program will find the break-even 

volume  
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(b) What number must U-Develop sell to make an operating profits 

of $300 per month? 

1. Repeat steps from 1 to 5. 

2. In the “To value:” edit field, enter the target profit which is 3000. 

3. In the “By changing cell:” edit field, enter the cell address of the 

volume variable ($B$8) and make it absolute reference. 

4. Click “OK” and the program will find the volume that achieves 

$3000 profits. 
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(c) Assuming 5000 units volume; what price do U-Develop needs to 

charge to break even? 

1. Repeat Steps 1 to 5 for Q (a) 

2. In the “To value:” edit field, enter the target profit (in this example, 

the target profit is zero because we are looking for the break-even 

point). 

3. In the “By changing cell:” edit field, enter the cell address of the 

price variable ($B$3). 

4. Click “OK” and the program will find the break-even price. 
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Exercises 

1. Cambridge, Inc., is considering the introduction of a new calculator 

with the following price and cost characteristics: 

Sales price . . . . . . . . . . . . . $ 18 each 

Variable costs . . . . . . . . . . . 10 each 

Fixed costs . . . . . . . . . . . . . . 20,000 per month 

Required 

Using the Goal Seek function in Microsoft Excel, 

a) What number must Cambridge sell to break even? 

b) Assuming a volume of 3000 units; what the price that Cambridge, 

Inc. must set in order to break even? 

c) What number must Cambridge sell to make an operating profit of 

$6,000 per month? 

2. Balance, Inc., is considering the introduction of a new energy 

snack with the following price and cost characteristics: 

Sales price . . . . . . . . . . . $ 1.00 per unit 

Variable costs . . . . . . . . . 0.20 per unit 

Fixed costs . . . . . . . . . . . 400,000 per month 
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Required 

Using the Goal Seek function in Microsoft Excel, 

a) What number must Balance, Inc., sell to break even? 

b) Assuming a volume of 600000 units; what the price that Balance, 

Inc. must set in order to break even. 

c) What number must Balance, Inc., sell to make an operating profit 

of $8,000 per month? 
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Part (4) 

Using A worksheet 
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Part (4) 

Using A worksheet 

 

Preparing Financial Statements from a worksheet: 

       When numerous adjustments are necessary or other complicating 

factors are present, companies often use a worksheet to assemble and 

classify the data that will appear on the statement of cash flows. The 

worksheet is merely a device that aids in the preparation of the statement. 

Its use is optional . 

      Steps in preparing an Expanded End-of-Period Spreadsheet: 

 Step(1): Enter the title. 

 Step (2): Enter the unadjusted trial balance. 

 Step (3): Enter the Adjustments. 

 Step (4): Enter the adjusted trial balance. 

 Step (5): Extend the accounts to the income statement and 

Balance Sheet Columns. 

 Step (6): Total the Income Statement and Balance Sheet 

Columns, compute the net income or net loss, and complete 

the spreadsheet. 

 



110 

 

Example: 
 

Brushstroke Art Studio 

unadjusted trial balance 

Dec ,31 ,2019 

  Dr Cr 

Cash 22380   

Client Fees Receivable 71250   

Supplies 6000   

Prepaid Studio Rent 2500   

Studio Equipment 96000   

Accumulated Depreciation: Studio 

Equipment   52000 

Accounts Payable   6420 

Note Payable   24000 

Interest Payable   480 

Unearned Client Fees   8000 

Income Taxes Payable   5000 

Capital   70000 

Client Fees Earned   82310 

Supply Expense 4000   

Salary Expense 17250   

Interest Expense 480   

Studio Rent Expense 11250   

Utilities Expense 3300   

Depreciation Expense: studio equipment 8800   

Income Taxes Expense 5000   

Total 248210 248210 
 

Other Data: 

 1. Supplies on hand at December 31,2019,total $ 1000. 

 2. The studio pays rent quarterly ( every 3 months) . The last 

payment was made November 1,2019. the next payment will be 

made early in February 2020. 
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 3. Studio equipment is being depreciated over 120 months (10 

years). 

 4. On October 1,2002, the studio borrowed $24000 by signing a 

12 month ,12% , note payable . The entire amount , plus interest 

, is due on September 30,2020. 

 5. At December 31,2019 , $3000 of previously unearned client 

fees had been earned. 

 6. Accrued , but unrecorded and uncollected client fees earned 

total $ 690 at December 31,2019. 

 7. Accrued , but unrecorded and unpaid salary expense totals $750 

at December 31,2019. 

 8. Accrued income taxes payable for entire year ending December 

31,2019,total $7000.the full amount is due early in 2020. 
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The difference between the income statement column totals is the net 

income (or net loss) for the period. The difference between the balance 

sheet column totals is also the net income (or net loss) for the period. 
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Selecting the Best Alternative Using Scenario 

Manager Tool 

 

       Scenario manager is a part of What-If Analysis menu in Excel. 

Scenario is a group of commands that are saved and replaced 

automatically by Microsoft Excel in the worksheet. It can be used to 

forecasting the results in case of changing the data used in attaining these 

results.  

       Scenario manager tool can be used to differentiate among 

alternatives. This is known in managerial accounting as Differential 

Analysis, where the company compares different alternatives for solving 

a specific problem with the aim of getting the best alternative for solving 

this problem. 

 

 

 

 

 

 

  



119 

 

Example 

           Suppose that a company produces and sells only one product and 

that it faces sequential losses. The following data represents the activities 

of this company: 

 Variable Costs per unit: 

o DM  $22 

o DL   $5 
 

 Marketing Costs: 

o Direct Marketing Costs   $4 

o Indirect (variable) Marketing Costs   $3 

 Fixed Costs: 

o Fixed Manufacturing Costs  $100,000 

o Fixed Marketing Costs   $50,000 

o Fixed Managerial Costs $50,000 

 The company sold 12,000 units during August 2014 at $50 per 

unit. 

 The company evaluates the following alternatives to overcome the 

losses that achieved during August 2014: 

 The special offer of selling additional 2000 units for a customer  at 

$40 per unit. The company will not incur any additional marketing 
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costs other than the direct marketing costs associated with these 

units.  

 Making advertising campaign leading to increasing fixed 

marketing costs by $50,000, with decreasing unit selling price to 

$48. Sales will be increased to 20,000 units. 

 Decreasing Fixed Managerial costs to $25,000, and decreasing 

selling price to $45. This will increase sales to 15000 units without 

incurring any additional manufacturing or marketing costs. 
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Solution 

1. Open a new worksheet 

2. Prepare an income statement for the current position. 

Consider the accounting principles during preparing it, 

meaning that sales should be calculated by multiplying the 

no. of units sold by sales price, variable cost items are 

calculated by multiplying the cost per units by the no. of 

units sold, finally, the fixed costs per unit are calculated by 

dividing the total fixed costs over the no. of units. The 

following table shows the income statement for the current 

position(you have to make this in your answer sheet). Note: 

You have to insert a row for the additional units and insert 

their values as zeros. 

3. From What-If Analysis menu select the command Scenario 

Manager. 

4. On the scenario manager tabulate click the “Add” button to 

add the variables of the first scenario. 

5. On the “Add Scenario” screen write a name for the first 

scenario, e.g. First Alternative.  

6. In the changing cells refer to cells B5 & B6 (the no. of 

additional units and their price). Then click “OK”. 
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7. A new screen appears to determine the values of the first 

scenario, you should write 2000 and 40 for the no. of 

additional units and the price for them, then click “OK”. 

8. “Scenario Manager” screen appears again, click “Add” to 

add the variables of the second scenario.  

9. “Scenario Manager” screen appears again to add the 

variables of the second scenario. Write “ Second Alternative 

as a name for the second scenario and refer to the cells of the 

basic units no., the basic selling price, and the fixed 

marketing costs. Then click OK. 

10. Insert the values of the second scenario which are 20000, 48, 

and 100000 for the basic selling price, and the fixed 

marketing costs respectively. then click “OK”. 

11. Add the variables of the third scenario, write “Third 

Alternative” as the name of the third scenario. Refer to cells 

of basic units no., basic selling price, and fixed 

manufacturing costs, then click “OK”. 

12. Insert the values 15000, 45, and 25000 for basic units no., 

basic selling price, and fixed manufacturing costs 

respectively.  
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13. After inserting all scenarios, click on “Summary” button to 

show the results of the differentiation among the three 

scenarios. On results cells refer to the cell of net income 

(loss). After clicking “OK” the scenario summary worksheet 

appears on the excel file. The scenario summary sheet 

includes the cells that are changing among alternatives in 

addition to the result cell which is the net income(loss) cell. 

You have to show this table in your answer sheet.  

14. It is clear that the second alternative represents the best 

option for the company. You can show the income statement 

using the values of this scenario by highlighting the name of 

the second scenario which is “Second Alternative” and 

clicking show button on the scenario manager screen. (You 

have to show this in your answer sheet). 
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Part (5) 

Questions  
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Answer the following questions: 

 

Question one: 

      Determine whether each one of the following 

statements is true or false: 

1. The term “spread” comes from ledger sheets that spread across 

facing pages in a journal used many years ago by bookkeepers and 

accountants. 

2. To select an adjacent range, click the cell in a corner of the range, 

drag the pointer to the cell in the opposite corner of the range, and 

release the mouse button. 

3. You can change the location of the Quick Access toolbar and 

customize it to include commands that you use frequently. 

4. If you want to create a series starting at 2 and increasing by 2, you 

can put 2 in the first cell and 4 in the second cell, select both cells, 

and then use the fill handle to extend the series to your desired end 

value. 

5. The contents of the active cell always appear in the Formula Bar. 

6. By default, gridlines, row numbers, and column letters appear in 

the worksheet but not on the printed page. 
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7. A formula with multiple operators is calculated using the order of 

evaluation. 

8. The result of the following equation in Excel: 8 – 16/ 2 ^3 is 6. 

9. To make Excel show FV in positive you should enter the value of 

periodical payments in negative 

10. When a cell contains a function or a formula, the Fill handle acts as 

a copy tool. 

11. The Save As command saves an existing workbook, using its 

current name and save location. 

12. In Excel 2010, the view shortcuts toolbar displays various 

messages as well as the status of the Num Lock, Caps Lock, and 

Scroll Lock keys on the keyboards 

13. To use the AutoFill technique Type the first few letters in a cell, 

and if a similar value exists in the same column, Excel suggests the 

existing value. 

14. To begin a formula in a cell, first type the # symbol 

15. If the column is too narrow, part of the data you enter in the cell 

will get deleted. 

16. An operand is a symbol that indicates the type of calculation to 

perform on the operands, such as a plus sign (+) for addition. 

17. Statistical functions manipulate quantitative data in a worksheet. 
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18. CEILING function is a statistical function that rounds a number to 

the nearest integer or to the nearest multiple of significance. 

19. COUNT function is a mathematical function that counts how many 

numbers are in the list of argument. 

20. AND function Returns TRUE if any argument is TRUE. 

21. A range is identified by the addresses of the cells in the upper-left 

and lower-right corners of the selected block of cells, separated by 

a colon. 

22. Only one cell can be active at a time. 

23. In the relative reference, the cell value is changed as the formula is 

copied. 

24. In an adjacent range, all cells touch each other and form a 

rectangle. 

25. Some mathematical operations, such as addition and subtraction, 

do not require functions.  

26. Status bar displays the active cell address or the name of the 

selected cell, range, or object. 
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27. File menu Contains commands that affect the overall appearance 

of a worksheet, including some settings that deal with printing. 

28. To move the active cell to the last used cell in the worksheet, you 

should click Alt+ Page Down.  

29. The Save command lets you save a workbook with a new name or 

to a new location   

30. Each formula is considered as a function but the opposite is not 

true.   

31. You can create an Excel workbook without starting the Excel 

application. 

32. The Quick Access toolbar contains frequently used commands that 

are independent of the tab displayed on the Ribbon. 

33. Insert menu contains commands used to insert a forum, name a cell 

or a rage, audit a formula, or control how Excel performs 

calculations. 

34. You must select the cell (activate the cell) before you add 

information to it. 

35. You cannot add or remove commands from the quick access 

toolbar. 

36. Copying duplicates the cell or range in another location, while also 

leaving the cell in its original location. 
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37. Split window allows the user to work in multiple areas of a large 

spread sheet and focus the view on specific cell ranges. 

38. By default, when a formula is created, references to cells or ranges 

are usually based on their position relative to the cell that contains 

the formula. 

39. Excel performs the operations from right to left according to the 

order of operator precedence. 

40. When a cell contains a function or a formula, the Fill handle acts as 

a copy tool. 

41. By default new workbooks contain three worksheets. 

42. An Excel workbook can be created without starting the Excel 

application. 

43. Each worksheet consists of 1,048,576 columns (numbered 1 

through 1,048,576) and 16,384 rows (labeled A through XFD). 

44. The active cell as a thick black border around it and its address 

appears in the formula bar. 

45. In excel application, the title bar displays the active cell address or 

the name of the selected cell, range, or object.  

46. In the excel application, the status bar is used to display the 

worksheet in a variety of views, each suited to a specific purpose. 
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47. A non-adjacent range consists of separate blocks of cells that are 

selected at the same time. 

48. When a range of cells is selected, every cell in the range is 

highlighted, except for the active cell. 

49. To begin a formula in a cell, first type the # symbol. 

50. If the column is too narrow, part of the data you enter in the cell 

will get deleted. 

51. Changing the Format of a cell changes the value of the number 

stored in the cell. 

52. If a long value doesn„t fit in a cell. Excel displays a row of * 

characters. 

53. The label classification is used for cells that contain text or for 

numbers that will not be used in calculations. 

54. Fill Series is used to fill a column or row with consecutive data. 

55. IRR function returns the internal rate of return where positive and 

negative cash flows are financed at different rates. 

56. DB function Returns the depreciation of an asset for a specified 

period by using the double-declining balance method or some 

other method that you specify. 

57. The order of the elements in a formula does not affect the final 

result of the calculation. 
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58. If the value for C7 is 2; C8 is 4; and F4 is 2, then the result of the 

equation =C7+C8*F4 is 12. 

59. STDEV.P function Estimates standard deviation based on a 

population. 

60. If the value for A2 is 10 and the value of A3 is 2, then, =A2+A3 is 

a better formula than =10+2 because of flexibility 
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Question Two  

Select the best answer: 

1. Which cell becomes active when you press the "Enter" key? 

A) Cell A1 .                  B) The cell at the bottom of the next column. 

C) The next cell down.  D) The cell at the end of the current row. 

2. Auto Fill (as it applies to Excel 2010) 

A) enables you to copy the contents of a cell or to continue a sequence by 

dragging the fill handle. 

B) is the fastest way to type A1 in the name box. 

C) is adjustable so you can display more or less characters in a column. 

D) helps carry over the fill to the remaining worksheets. 

3. A nonadjacent range 

A) is the best tool to to use to decide which numbers to select. 

B) is selected with the "Ctrl + Alt + Delete" key combination. 

C) contains two or more cells or ranges that are not touching each other. 

D) isn't possible in Excel 2010. 

4. If you type January in a cell and then drag that cell‟s fill handle up (or to the 

left), Excel places: 

A) December in the first cell, November in the second cell, and so on. 

B) February in the first cell, March in the second cell, and so on. 

C) Copy January on all the selected cells. 
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D) Excel gives error message. 

5. To move data to a new line when the cell is not wide enough to display all the 

contents, you should use the following button: 

A) Alignment                  B) Orientation                 

 C)Wrap text                  D)Merge 

6. To move to the next worksheet in Excel workbook you should use the shortcut 

keys: 

A) Ctrl + Page Down                               B) Ctrl + Page Up 

C) Ctrl + Right Arrow                             C) Ctrl + Left Arrow   

7. If you have sales data for a given month and you want to calculate the sales 

amount for days in which the quantity sold exceeds specific number of units. 

The proper function to be used is: 

A) SUM                        B) SUMIF                

C) COUNTA                D)COUNTIF 

8. The result of the following formula”=(2+8)/4*2^3” on Microsoft Excel is: 

 A) 2.333                                  B) 20                      

 C) 18                                       D) Another value 

9. The tool that is used to allocate limited resources among competitive demands is 

called: 

 A) Goal Seek           B) Scenario Manager          

 C) Data Table         D) Another tool 
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10. The scenario summary table produces by scenario manager tool includes all the 

following items except: 

 A) Changing cells                       B) Result Cells                   

 C) Current Values                      D) Slack    

11. When you enter text into a cell, which Excel feature works behind 

the scenes to recognize and correct common mistakes? 

A. Auto Change 

B. AutoText 

C. Spelling & Grammar Check  

D. Auto Correct 

12. The Formula Bar (as it applies to Excel 2010) 

A. Displays the name of a worksheet within a workbook. 

B. Is at the intersection of a column and a row. 

C. Identifies the address of the current cell. 

D. displays the content of the active cell 

13. To go to the last cell of the column and row that contain data you 

should use the following keys: 

A. Page up key 

B. Page Down Key 

C. Ctrl+ Home key 

D. None of the above 
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14. The result of the formula: 2X7+(8-5)^2/4 is: 

A. 64          

B. 15.4          

C. 15             

D. Another Value 

15. Which of the following causes Excel 2010 to recognize data 

entered into a cell as text rather than number format? 

A. Parentheses ( )                                                

B. Forward Slash (/) 

C. Percent sign (%) 

D. A space                                                             

16. ---------------- contains all the commands related to managing 

workbooks and working with workbook content 

A. Ribbon 

B. Quick Access toolbar 

C. Workbook window 

D. None of the above 

17. To calculate the total of a series of daily sales that exceeds 

specific amount, the most appropriate function is: 

A. SUMIF           

B. SUM             
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C. ADD             

D. Another Function 

18. --------------------- function Rounds number down, toward zero, to 

the nearest multiple of significance. 

A. FLOOR      

B. CEILING          

C. ROUND         

D. ABS  

19. The tab that displays the backstage view containing commands 

related to managing files and customizing the program is: 

A. File          

B. Insert           

C. Home         

D. View 

20. Which of the following do you use to move down one cell in an 

Excel 2010 worksheet? 

A. Enter key 

B. Right arrow key 

C. Page Up key 

D. Home key 
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21. What function adds all of the numbers in a range of cells? 

A. Calculate                                                   

B. Sum 

C. Compute                                                  

D. Add 

22. Which is an example of a formula? 

A. =add(A1:A2) 

B. =A1+A2 

C. A1+A2 

D. SUM(A1:A2) 

23. --------------------- function counts how many values in argument 

that are not empty. 

A. COUNT        

B. COUNTA         

C. COUNTIF         

D. None of the above 

24. Cost-Volume-Profit Analysis (CVP) can be done using ------------- 

function: 

A. WHAT IF     

B. GOAL SEEK                                                                                                

C. SCENARIO MANAGER        
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D. None of the above 

25. Which of the following do you use to move up one window in an 

Excel 2010 worksheet? 

A. Right arrow key                                             B. Enter key 

C. Page Up key                                                   D. Home key 

26. The Formula Bar (as it applies to Excel 2010) 

A. displays the name of a worksheet within a workbook. 

B.  is at the intersection of a column and a row. 

C.  identifies the address of the current cell. 

D.  displays the content of the active cell. 

27. A cell (as it applies to Excel 2010)  

A.  must have formulas entered into it. 

B.  cannot be used for labels or headings. 

C.  must have text entered into it. 

D.  is the intersection of a column and a row 

28. One of the methods of data entry is to enter the first value in a 

recognized series and use the fill handle to extend the series. This 

method is called: 

A. AutoFill                                        B. FillSeries 

B. AutoComplete                              D. None of the above 
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29. The result of the following formula”=2+8/4*2^3” on Microsoft 

Excel is” 

A. 2.333                                      B. 56                      

          C. 18                                           D. Another value 

30. The function that rounds a number  down to the nearest  integer is: 

A. ROUND                             B. INT             

 C. CEILING                           D. FLOOR 

31. The function that counts how many values in a range is: 

 A. COUNTA                         B. COUNT            

 C. COUNTIF                        D. SUM 

32. If you have a list of students in a specific subject and you want to 

calculate the number of passed students in each subject. What is 

the most suitable function that should be used? 

 A. SUMIF                             B. COUNT          

 C. COUNTIF                         D.COUNTA 

33. Suppose that you got L.E. 30,000 loan from a bank to be repaid on 

equal monthly payments over three years. What is the suitable 

formula that should be used to calculate the value of monthly 

installments assuming 7% interest rate? 

A. FV                                 B. PV                   

C. RATE                           D. PMT 
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34. The function that returns TRUE if all arguments are satisfied is: 

A. IF                      B. AND       

C. OR                   D. a combination of IF & OR functions 

35. A spreadsheet PROGRAM is defined as 

A) a software application used to create and modify a database. 

B) a software application used to create and modify text-based 

documents. 

C) a software application used to create and modify video 

presentations. 

D) a software application used to create and modify 

spreadsheets. 

36. A spreadsheet 

A) is the core of a slide presentation. 

B) is an electronic file that is used to write text and graphics on 

the web. 

C) is an electronic file that contains a grid of columns and rows 

for related data. 

D) is another word for a letter written on a computer. 
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37. A worksheet is defined as 

A) the background colour of a cell. 

B) a single spreadsheet that often contains formulas, functions, 

values, text, and visual aids. 

C) the current cell location of the insertion point as indicated by 

a dark border.   

D) an unfinished project. 

38. A workbook is defined as 

A) a file containing related worksheets  

B) an un-editable "picture" of data. 

C) the address of the current cell. 

D) similar to a spreadsheet but bound rather than electronic. 

39. To select an entire column in MS-EXCEL, press? 

A) CTRL + C 

B) CTRL + Arrow key 

C) CTRL + S 

D) None of the above 

40. In excel worksheet the “title bar”: 

A) Displays the data or formula stored in the active cell. It can 

also be used to enter or edit a formula, a function, or data in a 

cell. 
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B) Displays the active cell address or the name of the selected 

cell, range, or object. 

C) Displays the name of the workbook and the program. 

D) None of the above 

41. Which of the following is not a term of MS-Excel? 

A) Cells 

B) Document 

C) Columns 

D) Non of the above 

42. What happens when dollar signs ($) are entered in a cell address? 

(ex. $B$2:$B$10)? 

A) An absolute cell address is created. 

B) Cell address will change when it is copied to another cell. 

C) The sheet tab is changed. 

D) The status bar does not display the cell address. 

43. Which of the following causes Excel 2010 to recognize data 

entered into a cell as text rather than number format?  

A) A space 

B) Parentheses ( ) 

C) Forward Slash (/) 

D) Percent sign (%) 



152 

 

44. Which is an example of a formula? 

A) =add(A1:A2) 

B) =A1+A2 

C) A1+A2 

D) SUM(A1:A2) 

45. Which is an example of a function? 

A) =add(A3:A4) 

B) =A3+A4 

C) =SUM(A3:A4) 

D) A1+A2 

46. Which of the following syntax is correct regarding to SUM 

function in Excel? 

A) =SUM (A3, C2)  

B) =SUM (A1:C9) 

C) =SUM (A3:A11, C2:C10) 

D) All of the above 

47. Which of the following function will use to find the highest 

number in a series of number? 

A) MAX(B1:B3) 

B) MAXIMUM (B1:B3) 

C) HIGH (B1:B3) 
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D) HIGHEST(B1:B3) 

48. Which function Returns the future value of an initial principal 

after applying a series of compound interest rates 

A) FV function 

B) FVSCHEDULE function 

C) DURATION function 

D) EFFECT function 

49. What does COUNTA () function do?  

A) Counts cells having alphabets 

B) Counts how many numbers are in the list of arguments 

C) Counts how many values are in the list of arguments 

D) Counts the number of blank cells within a range 

50. The Ofunction that returns TRUE if any argument is TRUE is: 

A) AND Function 

B) TRUE Function 

C) IF Function 

D) OR Function 

51. The function that rounds a number down to the nearest  integer is: 

A) CEILING Function 

B) FLOOR Function 

C) ABS Function 
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D) INT function 

52. The PMT Function: 

A) Returns the number of periods for an investment 

B) Returns the payment on the principal for an investment for a 

given period 

C) Returns the periodic payment for an annuity 

D) None of the above 

53. The function that Estimates standard deviation based on the entire 

population is: 

A) STDEV.S 

B) STDEV.P 

C) MODE 

D) MEDIAN 

54. The function that returns the most common value in a data set 

A) MODE.SNGL function 

B) MODE.MULT function 

C) MEDIAN function 

D) None of the above 
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55. If you have a data for  group of applicants and you want to 

determine the selected applicant that passed two requirment out of 

three, the appropriate function here is: 

  A) IF                                B) AND      

 C) OR                               D) IF in combination wit OR 
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Question Three: 

1. On March 1, 2020, Ayman Ahmed, an accountant, opened his own 

accounting & auditing office, to be known as Ayman Ahmed 

Accounting & Auditing Office. The business adjusts and closes its 

accounts at the end of each month. The following trial balance was 

prepared at May 31, 2020, after 3 months of operations: 

Ayman Ahmed Accounting & Auditing Office 

Trial Balance 

May 31, 2020 

Account Titles Dr L.E. Cr L.E. 

Cash 20,000  

Accounting Fees Receivables 2500  

Unexpired Insurance 2,000  

Prepaid Rent 3,200  

Office Supplies 1,400  

Office Equipment 60,000  

Accumulated Depreciation: Office Equipment  1000 

Notes Payable  16,000 

Interest Payable  0 

Salaries Payable  0 

Unearned Accounting Fees Revenue  16,000 

Capital  60,000 

Drawings 4,000  

Accounting Fees Revenue  4000 

Salaries Expense 2,800  

Utilities Expense 1,100  

Rent Expense 0  

Office Supplies Expense 0  

Depreciation Expense: Office Equipment 0  

Interest Expense 0  

Insurance Expense 0  

Total 53,600 53,600 
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Additional Information: 

1- No interest has yet been paid on note payable. Accrued interest at May 

31 amounts to L.E. 300. 

2- Accrued Salaries that have not yet recorded or paid amounted to L.E. 

4,200 at May 31. 

3- Many clients are asked to make an advance payments for the accounting 

services to be rendered in future months. These advance payments are 

credited to the Unearned Accounting Fees Revenue account. During May, 

L.E. 8,000 of these advances were earned by the business. 

4- Some clients are not billed until all services relating to their matter have 

been rendered. As of May 31, services priced L.E. 4,000 had been rendered 

to these clients but had not yet been recorded in the accounting records. 

5- An insurance policy was pasurchased on March 1. The premium of L.E. 

3,000 for the first six months was paid and recorded as Unexpired 

Insurance. 

6- On April 1, L.E. 4,800 three months rent was paid in advance and 

charged to the Prepaid Rent account. 

7- Office supplies consumed during May amounted L.E. 400. 

8- The office equipment was purchased on March 1. 
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Required 

Prepare a 5-columns worksheet including the following: 

 Trial Balance 

 Adjustments 

 Adjusted Trial Balance 

 Income Statement 

 Balance Sheet 

 

2. Using Microsoft Excel 2010, show, theoretically, the steps of 

calculating the following: 

First:(Show the results for this question in your answer sheet): 

Al-Yasmin Company purchased a machine for L.E. 85,000, the estimated 

useful life is 5 years and the estimated residual value is L.E. 10,000. 

Calculate the annual depreciation expenses using the following depreciation 

methods: 

A- Straight Line 

B- Sum of the Year Digits. 
 

Second:(Show steps only) 

Mahmoud  Co. produces two types of products X & Y. The price of X is 

$9 per unit whereas the price of Y is $17.5 per unit. The co. uses three 

production resources; materials, labor, and machines. The available 

amounts of these resources are limited. 
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Information: 

1-Each unit of X needs 2 kg materials half an hour of DL and one 

machine hour. Each unit of Y needs 2 kg materials, 2 DL hours and 3 

machine hours. 

2- The cost of materials is $2 per kg, the cost of labor is $1 per hour, and 

the cost of machines is $1.5 per hour. 

3- The available resources are 4000 kg of materials, 2500 labor hours 

and 4800 machine hours. 

Required 

What are the optimum mix of these products that maximizes the 

company‟s profits? 

 

3. On March 1, 2020, Israa & Sara, accountants, opened their own 

accounting and auditing practice, to be known as Aswanko accounting 

Office. The business adjusts and closes its accounts at the end of each 

month. The following trial balance was prepared at March 31, 2020, 

after 1 month of operations: 
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Aswanko Accounting Office 

Trial Balance 

March 31, 2020 

Account Titles Dr L.E. Cr L.E. 

Cash 100,600  

Accounting Fees Receivable 0  

Unexpired Insurance 30,000  

Prepaid Rent 48,000  

Office Supplies 14,600  

Office Equipment 264,000  

Accumulated Depreciation: Office 

Equipment 
 0 

Notes Payable  160,000 

Interest Payable  0 

Salaries Payable  0 

Unearned Accounting Fees Revenue  160,200 

Capital  200,000 

Drawings 40,000  

Accounting Fees Revenue  15,800 

Salaries Expense 26,800  

Utilities Expense 12000  

Rent Expense 0  

Office Supplies Expense 0  

Depreciation Expense: Office Equipment 0  

Interest Expense 0  

Insurance Expense 0  

Total 536,000 536,000 
 

Additional Information: 

1- No interest has yet been paid on note payable. Accrued interest at 

March 31 amounts to L.E. 1800. 

2- Salaries earned by the office staff but not yet recorded or paid 

amounted to L.E. 34,700 at March 31. 
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3- Many clients are asked to make an advance payment for the 

accounting and auditing services to be rendered in future months. 

These advance payments are credited to the Unearned Accounting 

Fees Revenue account. During March, L.E. 77,000 of these advances 

were earned by the business. 

4- Some clients are not billed until all services relating to their 

matter have been rendered. As of March 31, services priced L.E. 

47,800 had been rendered to these clients but had not yet been 

recorded in the accounting records. 

5- A professional liability insurance policy was purchased on March 

1. The premium of L.E. 30,000 for the first 15 months was paid and 

recorded as Unexpired Insurance. 

6- On March 1, L.E. 48,000 12 months rent was paid in advance and 

charged to the Prepaid Rent account. 

7- Office supplies remaining on hand on March 31 amounted L.E. 

11,000. 

8- The office equipment was purchased on March 1 and is being 

depreciated over an estimated useful life of 10 years. 

 

 

 

 



164 

 

Required 

Prepare a 5-columns worksheet including the following: 

A. Trial Balance 

B. Adjustments 

C. Adjusted Trial Balance 

D. Income Statement 

E. Balance Sheet 

 

4. Using Microsoft Excel 2010, show, theoretically, the steps of 

calculating the following: 

First:(Show the results for this question in your answer 

sheet): 

Al-Samah Company purchased a machine for L.E. 100,000, the 

estimated useful life is 5 years and the estimated residual value is 

L.E. 10,000. Calculate the annual depreciation expenses using the 

following depreciation methods: 

A. Straight Line 

B. Double Declining Balance 
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Second:(Show steps only) 

Balance, Inc. is considering the introduction of a new energy snack 

with the following price and cost characteristics: 

Sales price . . . . . . . . . . . $ 1.00 per unit 

Variable costs . . . . . . . . . 0.20 per unit 

Fixed costs . . . . . . . . . . . 400,000 per month 

 

Required 

Using the Goal Seek function in Microsoft Excel: 

A. What number must Balance, Inc., sell to break even? 

B. What number must Balance, Inc. sell to make an operating 

profit of $8,000 per month? 

C. Assuming a volume of 600000 units; what the price that 

Balance, Inc. must set in order to break even. 

 

5. On June 1, 2020, Alsohagy, an attorney, opened his own legal practice, 

to be known as Alsohagy Law Office. The business adjusts and closes its 

accounts at the end of each month. The following trial balance was 

prepared at June 30, 2020, after 1 month of operations: 
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Alsohagy Law Office 

Trial Balance 

June 30, 2020 
 

Account Titles Dr L.E. Cr L.E. 

Cash 10,060  

Legal Fees Receivable 0  

Unexpired Insurance 3,000  

Prepaid Rent 4,800  

Office Supplies 1,460  

Office Equipment 26,400  

Accumulated Depreciation: Office Equipment  0 

Notes Payable  16,000 

Interest Payable  0 

Salaries Payable  0 

Unearned Legal Fees Revenue  16,020 

Capital  20,000 

Drawings 4,000  

Legal Fees Revenue  1,580 

Salaries Expense 2,680  

Utilities Expense 1,200  

Rent Expense 0  

Office Supplies Expense 0  

Depreciation Expense: Office Equipment 0  

Interest Expense 0  

Insurance Expense 0  

Total 53,600 53,600 
 

Additional Information: 

1- No interest has yet been paid on note payable. Accrued interest at 

June 30 amounts to L.E. 180. 

2- Salaries earned by the office staff but not yet recorded or paid 

amounted to L.E. 3,470 at June 30. 

3- Many clients are asked to make an advance payment for the legal 

services to be rendered in future months. These advance payments 



167 

 

are credited to the Unearned Legal Fees Revenue account. During 

June, L.E. 7,700 of these advances were earned by the business. 

4- Some clients are not billed until all services relating to their 

matter have been rendered. As of June 30, services priced L.E. 4,780 

had been rendered to these clients but had not yet been recorded in 

the accounting records. 

5- A professional liability insurance policy was purchased on June 1. 

The premium of L.E. 3,000 for the first six months was paid and 

recorded as Unexpired Insurance. 

6- On June 1, L.E. 4,800 three months rent was paid in advance and 

charged to the Prepaid Rent account. 

7- Office supplies remaining on hand on June amounted L.E. 1,100. 

8- The office equipment was purchased on June 1 and is being 

depreciated over an estimated useful life of 10 years. 

 

Required 

Prepare a 5-columns worksheet including the following: 

A. Trial Balance 

B. Adjustments 

C. Adjusted Trial Balance 

D. Income Statement 

E. Balance Sheet 
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6. Suppose that a company produces and sells only one product and that it 

faces sequential losses. The following data represents the activities of this 

company: 

- Variable Costs per unit: DM  $22; DL$5 

- Marketing Costs: Direct Marketing Costs $4; Indirect (variable) 

Marketing Cost $3. 

- Fixed Costs: Fixed Manufacturing Costs  $100,000; - Fixed 

Marketing Costs   $50,000- Fixed Managerial Costs $50,000. 

- The company sold 12,000 units during August 2014 at $50 per 

unit. 

* The company evaluates the following alternatives to overcome the 

losses that achieved during August 2020: 

1- A special offer of selling additional 2000 units for a customer at 

$40 per unit. The company will not incur any additional marketing 

costs other than the direct marketing costs associated with these 

units.  

2- Making advertising campaign leading to increasing fixed 

marketing costs by $50,000, with decreasing unit selling price to 

$48. Sales will be increased to 20,000 units. 
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3- Decreasing Fixed Managerial costs to $25,000, and decreasing 

selling price to $45. This will increase sales to 15000 units without 

incurring any additional manufacturing or marketing costs. 

 

Required 

A. Using Microsoft Excel, show the therotical steps to the 

analyze the current position of the company and to analyze 

the three possible alternatives. 

B. Show the following tables: 

i. The income statement for the current position. 

ii. Scenario Summary 

iii. The income statement for the best possible alternative 
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